
GamIan User Guide 

1. Tool Description 

GAMIAN is a design and mechanical ANalysis tool for KiriGAMI structures. Starting from designing cuts or                
incisions on any thin-film structure to solving for its final deformed configuration under planar loading, all the                 
steps can be carried out using GAMIAN. GAMIAN provides functionalities to select material, define the               
Kirigami geometry, perform meshing, and numerically solve for the deformation response using the nonlinear              
finite-element method. Using these capabilities, a user can iterate over the choice of materials and geometric                
dimensions and cut-patterns and achieve the desired deformation pattern of a Kirigami structure. 

2. A Quick How-To 

The response of a kirigami structure under stretching deformation can be simulated using the following basics 
steps: 

● Select a material in the ‘Material’ tab. 
○ The default material is Polyimide. 
○ To try a different material (that can be modeled using elastoplastic constitutive law) 

■ Fill out the material properties fields and… 
■ Upload a traction file. 

○ To review the stress-strain relation of the material, hit the ‘Show material’ button under 
‘Preliminary Plots’ 

● Define the geometry parameters in the ‘Geometry’ tab referring to the ‘Geometry Layout Reference’ 
○ Set the dimensions of the rectangular Kirigami sheet 
○ Set the dimensions and the number of notches on the planar surface of the sheet 
○ For the 2D view of the final Kirigami structure, hit the ‘Show geometry’ button under ‘Preliminary 

Plots’. 
● Generate the mesh in the Mesh tab. 

○ There are setting to refine the size and resolution, but default mesh settings tend to work well 
and limit run times to < 10min. 

○ When satisfied with the geometry and mesh setting, go ahead and hit “Generate Mesh”.  
● Execute the simulation in the Simulation tab. 

○ Click the “Run pre-check” button.  This will check that all the required files are in place to run the 
finite element simulation. 

○ Click the “Run Simulation” button 
● Review Results 

○ After the simulation completes you should see a line like: “Last Run: OK. Run Time: 00:04:10”. 
○ Currently, we provide download access to all products of the simulation and 2D plots of stress 

vs strain and Z-displacement data. 
○ Current download products: 

■ geom_kiri.step: Geometry file 
■ mesh_kiri.dat:  Text file containing mesh details 
■ mesh_kiri.med: Mesh file readable by Salome-Meca 

 



■ DXDYDZ_kiri.resu: Displacement result file 
■ vmisTresca_kiri.resu: Stress result file 
■ sigXXYYZZ_kiri.resu: Stress result file 
■ viz_kiri.rmed: Result file readable by ParaVIS module in Salome-Meca 
■ mesg_kiri.mess: Message file logging details of a simulation run 

 

3. Background 

Kirigami (‘kiri’- cut, ‘gami’- paper), an ancient art of paper cutting, offers a structural design platform to                 
yield unconventional mechanical and morphological responses by tuning the stiffness and deformation            
behaviors of the underlying material. Strategic kirigami incisions or notches applied on 2D precursor              
can enable the creation of highly deformable devices while maintaining the functional components             
strain-free, thereby offering significant implications for stretchable/reconfigurable electronics and soft          
robotics. As kirigami features yield geometric deformations that dominate the inherent material            
elasticity, the properties and structures of kirigami metamaterials can be controlled by the pattern and               
orientation of the incisions and notches. Under mechanical loading/stretching, 2D kirigami surface            
architectures morph into three-dimensional (3D) structures in the vicinity of patterned regions owing to              
buckling and mechanical bi-stability. GAMIAN can be used to predict the final morphology of a kirigami                
structure for a given choice of material and cut-patterns, and thereby optimize those parameters to               
achieve the desired morphology. 

4. Under the hood 

Many operations in GAMIAN relies on Salome-Meca which is open-source software for computer-aided             
design and finite-element analysis. It has different modules such as geometry module, mesh module,              
and finite-element analysis module (Code-Aster) which are invoked at different steps of GAMIAN             
workflow. 

5. Detailed Workflow 

GAMIAN workflow consists of four steps as discussed below: 

a. Material selection 

In this step, the user assigns the material parameter of the Kirigami structure. Currently, only those                
materials are allowed that follows an elasto-plastic constitutive law. The default material is Polyimide.              
To try a different material (that can be modeled using elastoplastic constitutive law), the user needs to                 
fill out the material properties fields (a in Figure 1) and upload a traction file (b in Figure 1). To review                     
the stress-strain relation of the material, hit the ‘Show material’ button under ‘Preliminary Plots’ (a in                
Figure 2). 

 

https://www.code-aster.org/spip.php?article303


 

 



 
 

b. Geometry definition 

In this step, the user defines the geometry parameters by referring to the ‘Geometry Layout Reference’.                
The user can set the dimensions of the rectangular Kirigami sheet 
(a in Figure 3), the dimension of the notches on the planar surface of the sheet (b in Figure 3), and the                      
number of notches (c in Figure 3). For the 2D view of the final Kirigami structure, hit the ‘Show                   

 



geometry’ button under ‘Preliminary Plots’ (b in Figure 2). The thickness direction is into the plane of                 
the 2D view. Also, the set of ticks in the 2D view is distance reference in millimeters. 
 

 

 



 

c. Mesh generation 

In this step, the user defines the meshing parameters and actually creates the geometry and mesh                
files. The meshing element is predefined to be a triangular prism. The base of a prism, essentially a                  
triangle, discretizes the planar surface of the Kirigami sheet and the height of the prism discretizes the                 
thickness direction (as shown in Figure 5). The user can control the height of the prism (a in Figure 4),                    
consequently the number of segments along the thickness, and the size of the 2D triangles (b in Figure                  
4). After setting the sizing control, the user can perform mesh generation by using ‘Generate Mesh’ (d                 

 



in Figure 4). This actually invokes a CAD (Computer-aided design) program to create geometry and               
generate the mesh. The meshing statistics is displayed (c in Figure 4).  
This step produces two files that can be downloaded from ‘File Downloads’ namely (i) geom_kiri.step (a                
geometry file readable by any CAD software), (ii) mesh_kiri.dat ( a text file containing mesh details), (iii)                 
mesh_kiri.med (a mesh file readable by CAD software-Salome). 
 

 

d. Simulation 

In this step, the user provides the parameters for a predefined Finite element analysis (FEA) setup of                 
the Kirigami structure and then runs the simulation. The FEA is preset to solve for the deformed                 
configuration of the structure under planar loading. During the loading process, the 2D kirigami surface               
architectures morph into three-dimensional (3D) structures in the vicinity of patterned regions owing to              
buckling. To break the buckling instability, a small perturbative force is applied in the out-of-plane               
direction. However, care should be taken so that the buckled configuration should be independent of               
the magnitude of perturbative forces. This can be ensured by keeping the perturbative force small and                
just enough to break the instability. Thus, the simulation is performed in two steps; Step 1: out-of-plane                 
perturbative force (FIgure 6) and Step 2: Stretching along the plane (Figure 7).  
 

 
 
Since the analysis involves large deformations and rotations of the structural elements, a nonlinear              
finite element code is used. Under nonlinear FEA, the problem is solved iteratively and the final value of                  

 



loading is achieved in a number of steps. In each step convergence of the solution is ensured up to a                    
certain tolerance. Different aspects of the iteration and convergence of the solution can also be defined. 
 

 
 
The user defines the magnitude of the perturbative force and the number of steps (N1) over which the                  
force is applied (a in Figure 8). The force is applied along the interior faces of the cuts as shown in                     
Figure. Next, the preset boundary condition of the problem is shown in Figure. The user defines the                 
extent to which the moving edge is stretched and the number of steps (N2) involved (b in Figure 8). 
 
Next, the user specifies every how many steps (Nsto) the FE solution is stored (c in Figure 8). This                   
means different results of the FEA will be available for (N1+N2)/Nsto steps.  
 
The user can also tune various convergence criteria (d in Figure 8). The description of the various                 
options can be found in these links: Link 1 and Link 2. In most of the cases, the default setting should                     
work well. 
 
Next, the user can verify that all files required to run the FE simulation are available using ‘Run                  
pre-check’ (e in Figure 8). And finally, the user can start the FE simulation using ‘Run simulation’ (f in                   
Figure 8). The progress of the simulation is indicated in the progress bar. The output window shows a                  
real-time sequence number that refers to the step for which the solution is stored and runs from 0 to                   
(N1+N2)/Nsto.  

e. Results and post-simulation plots 

The FE solution is processed to evaluate two quantities of interest; (i) Maximum stress in the structure                 
and (ii) Maximum out-of-plane (Z) displacement of the structure as a function of elongation. The               
elongation is presented in terms of strain which is calculated as  

train 00%s = L (initial length)
 d (end displacement) × 1  

The user can plot (i) using ‘Stress vs strain’ (c in Figure 2) and (ii) using ‘Z-disp vs strain’ (d in Figure 2)                       
under ‘Post Sim Plots’. 

 

https://cdm.ing.unimo.it/dokuwiki/_media/wikipaom2015/seminario_code_aster_edf_08-advanced-nonlinear.pdf
https://www.code-aster.org/doc/default/en/man_u/u4/u4.51.03.pdf


  
 
 
 
 
 
 
 

 



f. File downloads 

Different files that can be downloaded (d in Figure 2) are tabulated below: 

geom_kiri.step Geometry file dumped using ‘Generate Mesh’ readable by 
any CAD software 

mesh_kiri.dat Text file dumped using ‘Generate Mesh’ containing mesh 
details 

mesh_kiri.med Mesh file dumped using ‘Generate Mesh’ readable by CAD 
software- Salome 

DXDYDZ_kiri.resu Result file dumped using ‘Run Simulation’ used to plot ‘Z-disp 
vs strain’ 

VmisTresca_kiri.resu Result file dumped using ‘Run Simulation’ used to plot ‘Stress 
vs strain’ 

SigXXYYZZ_kiri.resu Result file dumped using ‘Run Simulation’ used to plot ‘Stress 
vs strain’ 

viz_kiri.rmed Result file dumped using ‘Run Simulation’ readable by CAD 
software- Salome-Meca using ParaVIS module 

mesg_kiri.mess Message file logging details of a simulation run formatted by 
the underlying Salome-Meca FE program (Code-Aster). 

 

6. Post-operation with result files 

Two of the result files can be visualized using the software Salome-Meca. First user should run                
Salome-Meca, then select ‘ParaVIS’ module, then from the ‘File’ menu select ‘Open ParaView File...’              
and select the result file. 

a. mesh_kiri.med file 

This file is for visualizing the mesh. 

b. viz_kiri.rmed file 

This file is for visualizing the deformed configuration and the stress field at the instant in which the                  
solution is stored i.e. (N1+N2)/Nsto frames in total. 
 

 



 
 
For a quick tutorial on how to use the ParaVIS module in Salome-Meca/Salome software, one can refer                 
to these two links: Link 1 and Link 2. 

 

https://www.youtube.com/watch?v=XaeK5w2uoF0&t=0s
https://youtu.be/MmKg9vwj7Zg?t=103

